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Software Overview 

File Menu Include:  New  Close  Save  Restore  Delete  Print Report  Print Setup  Exit 
Edit Menu Include:  Undo  Redo  Cut  Copy  Paste  Select All 
System Menu Include:  COM Setup  Baud Rate Setup  Time Setup  Company Setup Short Information Setup  

Default Controller Setup  Door/Controller Setup  Transfer Parameter  Real Time Monitor  Video Monitor  Verify 
Image 

Register Menu Include:  Initialize Controller  Initialize Card  Initial Password Setup  Register/Deregister 
Collect Menu Include:  Collect Raw Data  Import Raw Data 
Personnel Menu Include:  User Login  Change Login Password  User Maintenance  Import Personnel Name 

Code  Personnel Information Maintenance  Personnel Merit and Demerit Records  Data Base Maintenance  Copy 
Data  Restore Data 

Attendance Menu Include:  Holiday Setup  Late/Early/Overtime Setup  Diploma Setup  Title Setup  
Classification Setup  Department Setup  Shift Code Setup  Ask For Leave Maintenance  Work Time Maintenance  
Attendance Record Maintenance  Monthly Attendance Maintenance 

Help Menu Include:  Content  About  Background Picture Setup 
Navigate Menu Include:  First  Prior  Next  Last 
Item Menu Include:  Add Item  Delete Item  Copy Item  Paste Item 

 
How to login 
System start. The User Login dialog box appears. 

 
 
To login into the Sentry Access Control System 
1. In the Username box, select your name from the drop-down list. 
2. In the Password box, type your password. The initial password is 555. 
3. Click OK. 
 
New 
Click New creates a new record in current table. 
 
Close 
Click Close closes the active window. 
 
Save 
Click Save saves changes you made to the current record in the active window. 
 
Restore 
Click Restore reverses the changes that you made to the current record in the active window. The Restore command 
does not undo the changes if you have already chosen the Save command. 
 
Delete 
Click Delete deletes the current record from the active table. 



Print Report 
On the File menu, click Print Report. The Print Report dialog box appears. 

 
 
To print report 
1. In the Report List list box, select report name. 
2. In the Output option box, select types of output. 
3. Click OK button. 
4. The Find dialog box appears, add condition of inquiry for report. 
5. Click Find button. 
6. Click Print Preview dialog box appears, click Print Report button. 
 

Print Setup 
On the File menu, click Print Setup. The Print Setup dialog box appears. 

 
 



Exit 
Click Exit closes Sentry Access Control System application. 
 
Undo 
Click Undo reverses the last action. 
 
Redo 
Click Redo repeats the last action. 
 
Cut 
Click Cut removes the current selection. 
 
Copy 
Click Copy copies the current selection. 
 
Paste 
Click Paste inserts the last copied selection. 
 
Select All 
Click Select All selects all text in the active area. 
 
Comm. Setup 
Provides serial communications port for between the computer and the controller by allowing the transmission and 
reception of data through a serial port. If serial port is chose wrongly will cause the computer and the controller 
communication failure. Please adjust it correctly. 
 
To provides serial communications port 
1. On the System menu, click Comm. Setup. 
2. On the Comm. Setup menu, click Comm1 (Default) or Comm2 or Comm3 or Comm4 or Comm5 or Comm6 or 
Comm7 or Comm8. 
 
Baud Rate Setup 
Provides the baud rate for between the computer and the controller. Please keep it same with the baud rate of the 
controller. If select the baud rate wrongly will cause the computer and the controller communication failure. Please 
adjust it correctly. 
 
To provides baud rate 
1. On the System menu, click Baud Rate Setup. 
2. On the Baud Rate Setup menu, click 2400bps or 4800bps or 9600bps (Default) or 19200bps. 
 



Time Setup 
On the System menu, click Time Setup. The Time Setup dialog box appears. 

 
 
To adjust date and time of the controller 
1. Make sure between the computer and the controller are already connected. 
2. Select controller number from the Source List box to the Selected List box. 
3. Click OK. 
 

 Move selected items from the Source List box to the Selected List box. 

 Move all items from the Source List box to the Selected List box. 

 Move selected items from the Selected List box to the Source List box. 

 Move all items from the Selected List box to the Source List box. 
 
Company Setup 
On the System menu, click Company Setup. The Company Setup dialog box appears. 

 
 
To show the user-defined company in the first line of the LCD for controller 
1. Make sure between the computer and the controller are already connected. 
2. In the Company box, type your contents (less than 41 characters). 
3. In the ControllerId box, select your controller number from the drop-down list. 
4. Click Transfer. 



Short Information Setup 
On the System menu, click Short Information Setup. The Short Information Setup dialog box appears. 

 
 
To show the user-defined short information in the first line of the LCD for controller 
1. Make sure between the computer and the controller are already connected. 
2. In the UseMark column, click Using check box. 
3. In the Name column, select individual personnel from the drop-down list. 
4. In the StartTime column, type start time for activate. 
5. In the EndTime column, type end time for deactivate. 
6. In the Content column, type your short information (less than 201 characters). 
7. In the ControllerId box, select your controller number from the drop-down list. 
8. Click Transfer. 
 
To terminate short information for controller 
1. Make sure between the computer and the controller are already connected. 
2. In the grid, click to a line short information. 
3. In the ControllerId box, select your controller number from the drop-down list. 
4. Click Terminate. 
 



Default Controller Setup 
On the System menu, click Default Controller Setup. The Default Controller Setup dialog box appears. 

 
 
To initialize card have three mode 

Assign Reader option button: Assign a controller or a reader to initialize card. 
ID Issue Device option button: Assign a ID issue device to initialize card. 
IC Issue Device option button: Assign a IC issue device to initialize card. 

 
To video monitor have two mode 

Overlay option button: Use overlay mode to video monitor. 
Preview option button: Use Preview mode to video monitor. 

 



Door/Controller Setup 
On the System menu, click Door/Controller Setup. The Door/Controller Setup dialog box appears. Display all door 
and controller in list box, click to activate the right side tab: Door tab, Time Frame tab, Time Zone tab, Holiday 
control tab, Use Group tab, Authorized User tab, Controller tab. 
 
Door Tab 

 
 
Door Parameter: 

Control Type: In and Out(Default)  Only In, Random Out  A.P.B 
Enter Type: Only Card(Default)  Only Password  Card&Password. 
Card&Password Use Group: 00----15(use group number) 
Sensor Type: Sensor NO.  Sensor NC.  Fire Alarm NO.  Fire Alarm NC.  NULL 
Open Time: 0----254 second(Default 5 second) 
Close Time: 0----99 second(Default 30 second) 
Duress Password: 6 bit number string 
Access Password: 6 bit number string 
Access Password Use Group: 00----15(use group number) 
Open Door After First Entry: 00----15(use group number) 

 
Command Button: 

Open Door Once: Select a door number, click button to open the door in limited time(Open Time). 
Open Door Forced: Select a door number, click button to open the door always. 

 

 



Time Frame Tab 

 
Every door can set max 32 time frame, the serial number is 00 to 31, each time frame includes start time and end time, 
the description is as below: 

00: System will set as No Passing, user can not change it. 
01----30: System will set as No Passing, user can change it. 
31: System will set as 24 Hours Passing, user can not change it. 

 
Time Zone Tab 

 
Every door can set max 64 time Zone, the serial number is 00 to 63. Each time zone includes 4 time frame, user can 
change it freely, the description is as below: 

00----62: System will set as time frame 31(24 Hours Passing). 
63: System will set as time frame 00(No Passing). 

Every time zone has 4 time frame, as First Frame, Second Frame, Third Frame, Fourth Frame in turns. 



Holiday Control Tab 

 
 
One can manage the entry and exit to make it safe during the holiday. There are 8 types of holiday applying group to 
flexible manage. To set it in the Use Group Tab, please refer to the description of the Use Group Tab. 
 
To assign holiday for controller 
Move mouse to click the date, select type of holiday in the access menu, the date will be covered of the color square 
frame. 
 
Command Button: 

Prior Year: Go to the prior year display. 
Next Year: Go to the next year display. 
First Half Year: Go to 1----6 months of the current year display. 
Second Half Year: Go to 7----12 months of the current year display. 

 

 



Use Group Tab 

 
System provides each door 16 use group (00----15) to use in the card managing. And each card can be set different use 
group in the different door. Each setting item of use group: holiday plan and week plan. 
 
Holiday Plan: 
There are 8 kinds of holiday plan, each one can be set the different managing time zone. Please select each kind of 
managing time zone. 
 
Week Plan: 
The way to plan the week is as the way of the holiday plan. But one should plan the 7 days passing time zone of the 
week plan, then it will repeat every week. 
If there is holiday which is set as managing time zone in the week, it will run as the managed holiday. Otherwise it will 
run as the current day managed time of the week plan. 
System will set the 00# use group as 24 Hours Passing. Other use group will set as No Passing. User can change it freely. 
 
Authorized User Tab 

 
Check for authorized user list of each door. 



Controller Tab 

 
 
Controller Parameter: 

Menu PWD: set the menu password (There are blank when come out from the factory) 
Check Error: -99----99 second/day (default: 0 second/day, negative: adjust to slow, positive: adjust to fast) 
Back Light: NC.  NO. (Default)  Auto  Time Segment 
Time Segment: When Back Light is set as the Time Segment that means it is in light. 
Beep Hint: Keyboard  Bell  Hint 
Record Option: In Record  Out Record  Events  Fill Cycle  No Sameness  5 Digit CardId  Capacity Alarm 
I/O Port Setting: Relay1  Relay2  W26 Port1  W26 Port2  Self Port 

  Relay1: Lock1(Default)  Lock2  Bell  Alarm  illegality  NULL 
  Relay2: Lock1  Lock2(Default)  Bell  Alarm  illegality  NULL 
  W26 Port1: In1(Default)  Out1  In2  Out2  NULL  W26 Out  W34 Out  W44 Out 
  W26 Port2: In1  Out1  In2(Default)  Out2  NULL  W26 Out  W34 Out  W44 Out 
  Self Port: In1(Default)  Out1  In2  Out2  NULL 

Bell Time01----Bell Time16: System provides each door 16 Bell Time, user can change it freely. 
 
Command Button: 

Version Info: Read the information of the supplier from controller. 
Clear Alarm: Clear all alarm of controller. 
Clear Device: Device will clear all record and all Authorizing User, Restore all parameter of leave factory. 
Advanced Option: The Advanced Option dialog box appears. To set Duration and Week for bell. 

 

 
 

Fire Forced Open All Door: click button to open all door always. 
Copy Parameter: The Copy Parameter dialog box appears. From selected controller copy parameter to assigned 

controller. 



 

 
 
To copy parameter to assigned controller 
1. In Door/Controller Setup dialog box, select a door number in list box, Click Copy Parameter, the Copy Parameter 
dialog box appears. 
2. In Copy Parameter dialog box, Select door number in the Object Controller list box (user can make multiple 
selections in list box). 
3. In Parameter List, select parameter will to copy. 
4. Click OK. 
 
Transfer Parameter 
On the System menu, click Transfer Parameter. The Transfer Parameter dialog box appears. 

 
 
To adjust parameter of the controller 
1. Make sure between the computer and the controller are already connected. 
2. Select controller number from the Source List box to the Selected List box. 
3. Click OK. 
 

 Move selected items from the Source List box to the Selected List box. 

 Move all items from the Source List box to the Selected List box. 

 Move selected items from the Selected List box to the Source List box. 

 Move all items from the Selected List box to the Source List box. 
 



Real Time Monitor 
On the System menu, click Real Time Monitor. The Real Time Monitor dialog box appears. 

 
System is monitoring for brush card, it can display Name CardId Department Title Time Position In_Out Event 
Photo of Personnel. 
 
Command Button: 

Continue: To continue monitor. 
Cancel: Closes Real Time Monitor dialog box. 

 
Video Monitor 
On the System menu, click Video Monitor. The Video Monitor dialog box appears. 

 
System is monitoring for brush card, it can display Name CardId Department Title Time Position In_Out Event 
Photo of Personnel, and to capture image. 
 



Verify Image 
On the System menu, click Verify Image. The Verify Image dialog box appears. 

 
 
To verify image of personnel 
1. Click to activate the left side grid, select individual personnel from the grid. 
2. In the right-down side image box, will be display photo of individual personnel. 
3. Click to activate the right side grid, select date and time of personnel from the grid. 
4. In the right-up side image box, will be display image of capture. 
 
Initialize Controller 
On the Register menu, click Initialize Controller. The Initialize Controller dialog box appears. 

 
 
To initialize controller 
1. In the UseMark column, click Using check box. 
2. Click OK. 
 
To partake attendance for controller 
1. In the Attendance column, click Partake check box. 
2. Click OK. 



Initialize Card 
On the Register menu, click Initialize Card. The Initialize Card dialog box appears. 

 
 
To initialize card 
1. Make sure between the computer and the controller are already connected. 
2. Click Read Card. 
3. Brush card on the controller, a new card number will be add in the grid. 
 
Initial Password Setup 
On the Register menu, click Initial Password Setup. The Initial Password Setup dialog box appears. 

 
 
Initial Password is useful when Enter Type is set as Card&Password. It is set as initial password of personnel in 
register card. 
 



Register/Deregister 
On the Register menu, click Register/Deregister. The Register/Deregister dialog box appears. 

 
 
In the dialog box, to register card or deregister card for controller. And user can change access level of the card freely 
(access address level and access time level). 
 
To register card for the controller 
1. Make sure between the computer and the controller are already connected. 
2. In the Edit Toolbar, click New button. 
3. In the PersonnelId box, select holder of card from the drop-down list. 
4. In the CardId box, select number of card from the drop-down list. 
5. In the Deadline box, type deadline of card. 
6. In the Reg.Mark grid, move mouse to click in blank line, select Add Item in the access menu, the Access Level 
dialog box appears. 
 

 
 

In the Access DoorId box, select door number from the drop-down list. 
In the Use Group box, select use group number from the drop-down list. 
Click OK, add a new item in the grid. 

7. Click Register All. 
 



To deregister card for the controller 
1. Make sure between the computer and the controller are already connected. 
2. In the Edit Toolbar, click Find button, to search holder of card. 
3. Click Deregister All. 
 
To register a great quantity of card for the controller. If access level of the card are the sameness, such as the 
same department, in this way, we can set one of their access level as template to copy others. 
1. Make sure between the computer and the controller are already connected. 
2. Click Register Group, the Register Group dialog box appears. 

 
 

Select holder of card from the Source Personnel list box to the Selected Personnel list box. 
Select number of card from the Source Card list box to the Selected Card list box. 
Click OK. 

 



To register a great quantity of card for the new controller 
1. Make sure between the computer and the controller are already connected. 
2. Click Register Door, the Register Door dialog box appears. 

 
 

Select holder of card from the Source Personnel list box to the Selected Personnel list box. 
In the TransferMark column of Register Door Template grid, click Transfer check box. 
Click OK. 

 
Collect Raw Data 
On the Collect menu, click Collect Raw Data. The Collect Raw Data dialog box appears. 

 
 



To collect data of the controller 
1. Make sure between the computer and the controller are already connected. 
2. Select controller number from the Source List box to the Selected List box. 
3. Click OK. 
 

 Move selected items from the Source List box to the Selected List box. 

 Move all items from the Source List box to the Selected List box. 

 Move selected items from the Selected List box to the Source List box. 

 Move all items from the Selected List box to the Source List box. 
 
Import Raw Data 
On the Collect menu, click Import Raw Data. The Import Raw Data dialog box appears. 

 
 
To import raw data to database 
1. In the Collect Start Date box, select date or type date. 
2. In the Collect End Date box, select date or type date. 
3. Click OK. 
 
User Login 
On the Personnel menu, click User Login. The User Login dialog box appears. 

 
 
To login into the Sentry Access Control System again 
1. In the UserName box, select your name from the drop-down list. 
2. In the Password box, type your password. 
3. Click OK. 



Change Login Password 
On the Personnel menu, click Change Login Password. The Change Login Password dialog box appears. 

 
 
Allows you to change your password 
1. In the OldPassword box, type your old password. 
2. In the NewPassword box, type your new password. 
3. In the Confirm NewPassword box, type your new password again. 
4. Click OK. 
 
User Maintenance 
On the Personnel menu, click User Maintenance. The User Maintenance dialog box appears. 

 
 
In the dialog box, to add or edit or save or delete or find information of user. 
 
To add a new user 
1. In the Edit Toolbar, click New button. 
2. In the UserName box, type name of user. 
3. In the Edit Toolbar, click Save button. 
 



Import Personnel Name&Code 
On the Personnel menu, click Import Personnel Name&Code. The Import Personnel Name&Code dialog box 
appears. 

 
 
To import personnel name and code 
1. In the Source File box, type or select text file (*.TXT) . 
2. Click OK button. 
 
Personnel Information Maintenance 
On the Personnel menu, click Personnel Information Maintenance. The Personnel Information Maintenance dialog 
box appears. 

 
 
In the dialog box, to add or edit or save or delete or find information of personnel. 
 
To add a new personnel 
1. In the Edit Toolbar, click New button. 
2. In the Name box, type name of personnel. 
3. In the Code box, type code of personnel. 
4. In the Edit Toolbar, click Save button. 



Personnel Merit and Demerit Records 
On the Personnel menu, click Personnel Merit and Demerit Records. The Personnel Merit and Demerit Records 
dialog box appears. 

 
 
In the dialog box, to add or edit or save or delete or find or print merit/demerit of personnel. 
 
To add a new merit/demerit of personnel 
1. Click Add button. 
2. In the PersonnelId column, select number of personnel from the drop-down list. 
3. In the Type column, select merit or demerit from the drop-down list. 
4. In the Reason column, type reason for merit/demerit. 
5. Click OK button. 
 
Data Base Maintenance 
On the Personnel menu, click Data Base Maintenance to validate database. 
 
Copy 
Click Copy copies the current selection. 
 
Restore 
Click Restore reverses the changes that you made to the current record in the active window. The Restore command 
does not undo the changes if you have already chosen the Save command. 
 



Holiday Setup 
On the Attendance menu, click Holiday Setup. The Holiday Setup dialog box appears. 

 
 
The dialog box display a perpetual calendar. 
 
To assign holiday for software system 
Move mouse to click the date, select Holiday in the access menu, the date will be covered of the red square frame. 
 
Command Button: 

Prior Year: Go to the prior year display. 
Next Year: Go to the next year display. 
First Half Year: Go to 1----6 months of the current year display. 
Second Half Year: Go to 7----12 months of the current year display. 

 



Time Setup 
On the System menu, click Time Setup. The Time Setup dialog box appears. 

 
 
To adjust date and time of the controller 
1. Make sure between the computer and the controller are already connected. 
2. Select controller number from the Source List box to the Selected List box. 
3. Click OK. 
 

 Move selected items from the Source List box to the Selected List box. 

 Move all items from the Source List box to the Selected List box. 

 Move selected items from the Selected List box to the Source List box. 

 Move all items from the Selected List box to the Source List box. 
 



Diploma Setup 
On the Attendance menu, click Diploma Setup. The Diploma Setup dialog box appears. 

 
 
To add a new diploma 
1. Click Add button. 
2. In the Diploma box, type name of diploma. 
3. Press <Enter> key to save. 
 
Title Setup 
On the Attendance menu, click Title Setup. The Title Setup dialog box appears. 

 
 
To add a new title 
1. Click Add button. 
2. In the title box, type name of title. 
3. Press <Enter> key to save. 
 



Classification Setup 
On the Attendance menu, click Classification Setup. The Classification Setup dialog box appears. 

 
 
To add a new classification 
1. Click Add button. 
2. In the classification box, type name of classification. 
3. Press <Enter> key to save. 
 
Department Setup 
On the Attendance menu, click Department Setup. The Department Setup dialog box appears. 

 
 
To add a new department 
1. Click Add Root button. 
2. Move mouse to click in the click to edit text area, to activate click to edit text box. 
3. In the click to edit text box, type name of department. 
4. Press <Enter> key to confirm. 
5. Click Save button. 



Shift Code Setup 
On the Attendance menu, click Shift Code Setup. The Shift Code Setup dialog box appears. 

 
 
To add a new shift code 
In the grid, move mouse to click in blank line, select Add Shift Code in the access menu, the Add Shift Code dialog 
box appears. 

 
 



In the ShiftCode box, type code of shift (less than 5 characters) . 
In the No.1 Start Time box, type work start time (hour and minute) . 
In the No.1 End Time box, type work end time (hour and minute) . 
Click OK button. 

 
Other Parameter: 

Midway Rest: Include midway rest time in the frame work time. 
Midway Overtime: Include midway overtime time in the frame work time. 
Overtime: The frame work time will be treated as overtime time (Weekday, Rest, Legal). 
Directly Overtime: Brush card time greater than work end time will be treated as overtime time. 
non-EndTime: non-Brush card will be treated as normal in work end time. 

 
Example: 
1.In the factory, the work time of administer personnel is: {08:00--12:00} and {13:30--17:30} as normal work time. Set 
as down: 

 
 



2. In the factory, the work time of manufacture personnel is: {08:00--12:00} and {13:30--17:30} as normal work time, 
{18:30--22:30} as overtime time. Set as down: 

 
 

3. In the factory, the work time of manufacture personnel is: {00:00--08:00}, {08:00--16:00} and {16:00--00:00} three 
frame time as shift work time. Set as down: 

 
 
 



4. In the factory, the work time of manufacture personnel is: {08:00--12:00} and {13:30--17:30} as normal work time, 
{13:30--17:30} as directly overtime time. Set as down: 

 
 



Ask For Leave Maintenance 
On the Attendance menu, click Ask For Leave Maintenance. The Ask For Leave Maintenance dialog box appears. 

 
 
To add a new leave record 
1. Click to activate the top side grid, select individual personnel from the grid. 
2. Click Add button. 
3. In the StartTime column, type start time. 
4. In the EndTime column, type end time. 
5. In the Type column, select types from the drop-down list. 
6. In the Auditor column, select auditor from the drop-down list. 
7. In the Reason column, type reason. 
 



Work Time Maintenance 
On the Attendance menu, click Work Time Maintenance. The Work Time Maintenance dialog box appears. 

 
 
To plan work time for personnel 
1. In the Work Start Date box, select date or type date. 
2. In the Work End Date box, select date or type date. 
3. Click Generate Initial Plan button, to plan work time for all day of anyone.(Personnel must be assigned a ShiftCode 
in the Personnel Information Maintenance dialog box) 
4. If you want to adjust ShiftCode of relevant day, in the ShiftCode column of in the right side grid, select ShiftCode 
from the drop-down list. 
5. Click Confirm Plan button, automaticaiiy confirm plan work time. 
 
To adjust a great quantity of shiftcode for the personnel. If shiftcode of the personnel are the sameness, such as 
the same department, in this way, we can set one of their shiftcode as template to copy others. 
1. Click Assign Plan by Group button, the Assign Plan by Group dialog box appears. 



 
 

Select personnel from the Source Personnel list box to the Selected Personnel list box. 
In the ShiftCode column of in the Assign Template grid, select ShiftCode from the drop-down list. 

Click OK button. 
 



Attendance Record Maintenance 
On the Attendance menu, click Attendance Record Maintenance. The Attendance Record Maintenance dialog box 
appears. 

 
 
To verify attendance record for personnel 
1. Click Verify button, automaticaiiy verify attendance record for anyone. 
 
Grid Description: 

DateTime column: Display work time of plan. 
Week column: Display week of relevant date. 
No. column: Display number of times for that day brush card. 
ClockIn_Out column: Display actual brush card time. 
Result column: Display result of verify attendance.(Attend, Late, Early, Absent, Holiday, Overtime, Rest-Overtime, 

Legal-Overtime, Non-Overtime, Evection, Egress, Sick, Event, Swap, Wound, Marry, Maternity, Funeral or 
Early&Late) 

Value column: Display value of result. 
ShiftCode column: Display ShiftCode of that day. 

 



Monthly Attendance Data Maintenance 
On the Attendance menu, click Monthly Attendance Data Maintenance. The Monthly Attendance Data 
Maintenance dialog box appears. 

 
 
To copy attendance data of current month 
1. Click Copy button, The Attendance Month dialog box appears. 
2. In the Attendance Month box, type month of copy. 
3. Click OK button. 
 
To recall attendance data of assigned month 
1. In Attendance Month list box, select a month. 
2. Click Recall button. 
 
To delete attendance data of assigned month 
1. In Attendance Month list box, select a month. 
2. Click Delete button. 
 



Contents 
On the Help menu, click Contents (or press <F1> key). The Contents dialog box appears. 

 
 
About 
On the Help menu, click About. The About Sentry Access Control System dialog box appears. 

 
 
Displays program information about Sentry Access Control System. 

 
 



Background Picture Setup 
On the Help menu, click Background Picture Setup. The Background Picture Setup dialog box appears. 

 
 
To assign background picture for software system 
1. In the Source File box, type or select picture file. 
2. Click OK button. 
 
First: Click First displays the first record of the current table. 
 
Prior: Click Prior displays the prior record of the current table. 
 
Next: Click Next displays the next record of the current table. 
 
Last: Click Last displays the last record of the current table. 
 
Add Item: Click Add Item adds a new line to the grid for adding another Access Level to the personnel. 
 
Delete: Click Delete deletes the current record from the active table. 
 
Copy: Click Copy copies the current selection. 
 
Paste: Click Paste inserts the last copied selection. 
 
How to install software 
To install software from disc 
1. Insert the compact disc in the CD-ROM drive. 
2. Double-click Setup.exe. 
3. Follow the setup instructions in the setup wizard. 
 
How to grant IC card 
To grant IC card for useful 
1. Click Personnel Information Maintenance menu item in the Personnel menu, to add personnel. 
2. Click Initialize Controller menu item in the Register menu, to add controller. 
3. Click Initialize Card menu item in the Register menu, to add IC card. 
4. Click Register/Deregister menu item in the Register menu, to register IC card. 
 
How to verify result of attendance 
To verify result of attendance 
1. Click Collect Raw Data menu item in the Collect menu, to collect attendance data. 
2. Click Import Raw Data menu item in the Collect menu, to import attendance data. 
3. Click Work Time Maintenance menu item in the Attendance menu, to plan work time of personnel. 
4. Click Attendance Record Maintenance menu item in the Attendance menu, to verify result of attendance. 
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